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Installation documentation consists of documents:

1. Installation of Bl4Dynamics application (covered by this document)
2. Installation of Bl server on Local Machine or Azure Virtual Machine (VM)

1.1. Implementation options
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1.2. Prerequisites

Description

Value

BC Admin User

adminuser@bi4dynamics.onmicrosoft.com

BC Admin User Password

rtPxXgxJ2IkOlJFRIEki#8

All prerequisite fields are result of that Local or VM installation (fields here are for example only):

Azure Storage:

Description

Value

Subscription

Pay-As-You-Go

Resource Group

vm-bi4-demo

Azure Storage Account

vmbi4demostorage

Storage Account Blob Key

4T+eDbvoU7G7Wd785S0P86V++VBdglaPeTTHHvun1IGgN4l==

Azure Container instance:

Description

Value

Subscription

Pay-As-You-Go

Container Instance

vmbiddemocontainer

Azure Analysis Services — implementation option B:

Description

Value

Azure Analysis Services

asazure://westeurope.asazure.windows.net/bi4dynamicshybrid

Username (AAS admin)

mg@bi4dynamics.com

Password

Qpewoicsj490wkss

Power Bl Premium — implementation option C:

Description

Value

Workspace connection

Power Bl://api.Power Bl.com/v1.0/myorg/Bl4Dynamics%20PPU%

Username (Power Bl)

mg@bi4dynamics.com

Password

Qpewoicsj490wkss



mailto:adminuser@bi4dynamics.onmicrosoft.com
mailto:mg@bi4dynamics.com
mailto:mg@bi4dynamics.com

1.3. Installing Bl4Dynamics application

Install Bl4Dynamics BC Extension to your BC tenant. Extension must be installed on Production
environment. As this is a standard BC installation, we will not describe steps.
https://www.bi4ddynamics.com/dl/azure/APP.zip

b This PC # Downloads » APP

Mame Type

| Bl4Dynamics_Bl4DynamicsStandardExtension_1.0.3.0.app APP File

Any other extensions you might be using in BC and plan to include in the Bl project must be installed
on Production and on the Sandbox environment.

Microsoft does not permit reading all the extension information (Symbols) directly from Production
environment, therefore Bl4Dynamics is using the Sandbox environment to read the Symbols (extension
Metadata).

IMPORTANT! Before installing Bl4Dynamics, please check hardware and software requirements, make
sure you have sufficient permissions and an active internet connected.

IMPORTANT! The installation process must be started on VM where Bl4Dynamics Data Warehouse will
be created.

1. Double-click BI4Dynamics.exe to start the installation*.

*Always start BI4Dynamics as an administrator.
Note: The name of the file varies based on the version you are using.

2. Follow the instructions on screen and Accept the license agreement.

B Bl4Dynamics Installation Wizard = 3 Bl4Dynamics Installation Wizard ®
Accept license agreement
Wel to Bi4Dy ics i ! Please carefully read the license agreement and accept it
The wizard will install BI4Dynamics on your computer. E nd_Use r Softwa re Lice nse Ag ree ment 2

Please read this agreement carefully before purchasing, installing, copying,
downloading or using BlADynamics software. By installing, copying, downloading or
using Bl4Dynamics's software, Licensee agrees to be bound by the terms of this
limited use license.

WARNING: This program is protected by copyright law and

intemational treaties. This end user software license agreement ("AGREEMENT") is a legal agreement

between "Licensee” (the individual or entity) who acquired or subscribed to the
Bl4Dynamics software products and documentation (collectively, “Software,”)
accompanying this AGREEMENT and BI4 DYNAMICS UK Ltd, ("BI4DYNAMICS"). By ©

Press Next to continue. [] 1 accept the license agreement

[ het> | [ Cance < Back Cancel
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Choose the Default option.

& Bl4Dynamics Installation Wizard X

Installation type
Please choose installation type that best fits your needs

Please choose appropriate installation type

@® Default

O Express

Install data warehouse only

The installer will check for some of the prerequisites. If you fail any of the tests you can click on
the result to see the error. You must fix the problem before you can rerun the test. Once all the
tests are successfully completed you can continue with the installation.

EB El4Dynamics Installation Wizard X
Check prerequisites

Please wait while installation wizard is checking program prerequisites

Below is a list of program prerequisites

Fule Resuft )
/N | SOL Server Waming
_ﬁ SQL Analysis Server Waming
_:5 SQL Server Agent Waming
.a Operating system Passed
(@ | NET Framework Passed
9 Shared Management Objects Passed w
Re-un

Please review wamings in the list above

< Back Mext > Cancel

If a correct version of Shared Management Objects, Analysis Management Objects or .NET
Framework are not installed, please click the Install button, which will trigger the installation of
correct version of SMQO's, AMO's, CLR Types or .NET Framework.

Select the folder where you would like to install BIi4Dynamics. You can choose to create a shortcut
on the desktop and/or in the start menu.

A B14Dynamics Installation Wizard =

Installation location

Please choose where the program should be installed

Program will be installed in the following location

C:\Program Files (<86\Bl4Dynamics".

Create & shortcut for this program on the desktop
[] Create a shortcut for this program in the start menu

Disk space
Total space $0.1GB
Free space 324GB

<Back | [ Net> | [ cancel




7. Confirm the configuration and begin the installation of BI4Dynamics.
8. Click Finish after the installation is completed.
(m Bl4Dynamics Installation Wizard [&r

Configuration finished

The ingtaller has finished configuring application on this
computer.

Press Finish to esdt installer.




1.4. Creating Bl4Dynamics instance

Deploying a Bl4Dynamics solution is a six-step process:

Providing license information
Creating an instance

Adding the data sources

Selecting companies

Selecting Azure Framework module
6. Deploying and processing model

vk w2

When you open the application, an instance wizard will start to guide you through the configuration.

1. Launch Bl4Dynamics.exe from the folder where Bl4Dynamics was installed to open application.

Deploy manual i
scripts only

Instance Wizard

License Information

Online authentication - enter license key:

OR

Offline authentication - import license file:

This process is used only if customer server is not on-line

Step 1: Generate Server ID

ase wait up to 30 seconds..)
Step 2: Send Server ID to sales@biddynamics.com
Step 3: Wait to receive BI4Dynamics license file

le wil be sent by our support team)

Step 4: Import license file m

(please wait up to 30 seconds..)

T =

Note: Bl4Dynamics is 64-bit application, but the default installation location is C:\Program Files
(x86)\Bl4Dynamics NAV. Application can also be started from the Desktop shortcut or from the Start Menu
shortcut.

2. Enter the Bl4Dynamics online license key

OR
Follow the instructions on screen to receive an offline license key (in case you do not have the
internet connection or port 80 on the server is closed).
Offline authentication - import license file:
This process is used only if customer server is not on-line

Step 1: Generate Server ID

(please wait up to 30 seconds...)

Step 2: Send Server ID to support@biddynamics.com

Step 3: Wait to receive Bl4Dynamics license file

(file will be sent by our support team)

Step 4: Import license file

(please wait up to 30 seconds...)

Note: If you experience any problems with authorization, please contact us via support@biddynamic.com.

3. Click Next.
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2.1. Creating Instance

Instance properties

1. Check the Source is BC Cloud checkbox.
2. Type the Name of the new instance.
3. Select what Language the solution will be deployed in.

SQL server

1. Keep or change Database Name of the Bl4Dynamics Data Warehouse.

2. Type SQL server name

3. Select or Type in the SQL Server Instance name where the Bl4Dynamics Data Warehouse will be
deployed.

4. Authentication type: Windows

New Instance

Instance properties

Source is BC Cloud (5aaS):

Instance Name: Bl4Dynamics BC OnPremise

Language: English (United States) -

SQL Server Analysis Services

Database Name: Bl4Dynamics BC OnPremise Analysis Database Name: Bl4Dynamics BC OnPremise

SQL Server Name: MLADENNUC\BC = Analysis Server Name: MLADENNUC\BC -
Authentication: Windows - Authentication: Windows -

Username: NP5-GROUP\mgvozden
Password:
Analysis Server Option: Tabular -

Mode type: Import h

Analysis Services

1. Keep or change the Analysis Database Name of the Analysis Services instance.

2. Keep or change the Analysis Database Server name where the Analysis Services model will be
deployed.

3. Authentication type: Windows

This is the current setting on the form, and we continue with installation:



Integration Services ST E—
Check SQL Integration Service to process Bl4Dynamics | ===~

Dynan OnPremse

using the Integration services (parallel processing). ST .
Refresh ;?th::e: Analysis Services
Click Refresh to set default values for SQL Database
file Locations (data and log files) and SQL Database
Collation are entered automatically. Modify if i -
necessary.

Test

Please note that

- VM is for installation on of Azure SQL VM
- Local is for local server installation

We are testing more resources on VM than on Local.

Click VM or Local to test resources that must be installed on VM or Local Machine to proceed with BC
installation. Diagnostics message should confirm that all resources are available, set and running. In case
any of these shows ERROR, stop BC installation and fix the reported service error. This should be the
message:

Diagnostics x
i Polybase: Running
| | Polybase enabled: OK
- Hadoop Connectivity enabled: OK
Azure CLI Check: OK
Azure CLI Check: v.2.19.1
Continue and click Refresh to update file locations
Click Next.

Azure Storage Information
This information is about Azure Storage Account that will be used to keep BC data. The values have
been created during VM installation and are listed as a prerequisite for BC application installation.

Type Subscription that is used for Storage Account

Type Virtual Machine Resource Group as VM Resource Group

Type Storage Account Name

Type Container Name (this resource should not be confused for Container instance aca Docker,
that is another Azure resource, used for exporting tables to Storage Account)

5. Type Blob Key

Click Test to check if the entered information is correct.

Hwn =

License Information Add Data Sources

2 New Instance .
winsta Add all NAV source databases you wish to analyze in Bl4Dynamics to your Bl4Dynamics instance.

Azure Storage Information

Subscription: Pay-As-You-Go

VM Resource Group: vm-bi4-demo

Storage Account Mame: vmbiddemostorageaccount
Container Name: wvmbiddemocontainer

Blob Key: S504Gr1dCLgciaxFY0AGOaThFgyFVpé

Test Storage Credentials:




Click Test to test entered information.
A new window will require authentication. Enter Azure portal admin user and password:

Creating the AAD application BI4

Sign in to your account.
B2 Microsoft
Sign in

[mail, phone, or Skype

No account? Create one!

Can't access your account?

Sign-in options

EX Administrator: Cwindows\System32\WindowsPowerShell\w1.0\powershell.exe - O

Untrusted repository . . ) .

You are installing the modules from an untrusted repository. If you trust this repository, change its
InstallationPolicy value by running the Set-PSRepository cmdlet. Are you sure you want to install the modules from
v

sGallery'?
[¥] Yes [A] Yes to A1l [N] No [L] No to A1l [S] spend [?] Help (default is '

Wait few minutes to start downloading and installing packages

EX Administrator: Cwindows\System32\WindowsPowerShell\wl.0\powershell.exe

Intrusted repository

Installing package 'Az'
Installing dependent package 'Az.Resources’
[00000000000000000000000000000000000000000000000000000000000000) B
Installing package 'Az.Resources’ 2 mlnutes
Process Package Manifest
[00000000000000000000000000000C000000000000000000000000000000

On finish this message pop-us to confirm that resources are entered correctly:

Bl4 Diagnostics X

. Resource Group: OK
Storage Account: OK
Storage Container: OK

Business Central
Click Login to login into Azure with BC admin credentials.

Add Data Sources

Add all NAV source databases you wish to analyze in Bl4Dynamics

Azure Storage Information

Subscription: Pay-As-You-Go

Resource Group: vm-bi4-demo

Storage Account Name: vmbiddemostorageaccount
Container Name: vmbiddemocontainer

Blob Key: ynnvyiT obPZ7tcNUPVEMCmT6X V==

Test Storage Credentials:

Data Source Information

Business Central

Business Central Login: ‘

BC Tenant ID:

App Registration Client ID:

BC Enviroment Name: b

BC Sandbox Enviroment Name: h

Initialize Data Lake




A new window will open:

‘(reating the AAD application BI4

|
‘ Signin to yeur account
|

B Microsoft

Sign in

[Email, phone, or Skype

No account? Create ane!
Can't access your account?

sign-in aptions

Enter username and password for BC admin (first time)

After entering password wait 15 seconds to sign in again. In this process, BC admin will allow Bl4Dynamics
application to access BC data. Enter BC admin credentials (second time):

Sometimes, account login does not work correctly. Use option Use another account and enter the same
BC admin account credentials.

B® Microsoft

Pick an account

El admin.user@bi4dynamics.onmicrosoft.com
|E| john_smith@bi4dynamics.com
+ Use another account

Back

New window will pop-up:

B Microsoft

dev@bidd.onmicrosoft.com

Permissions requested

Bl4.

#pp info;

This application is not published by Microsoft.

This app would like to:
v Have full access to Dynamics 365 Business Central

v Sign you in and read your profile

Accepting these permissions means that you allow this app to use your
data as specified in their terms of service and privacy statement. You can
change these permissions at https://myapps.microsoft.com. Show details

Doss this app look suspicious? Repart it here 0,

1 minute

Click Accept and wait ...



Application will automatically fill-in BC Tenant ID and App Registration Client ID:
(You can enter this information if you have it from previous process without login process)

Add Data Sources

Add all NAV source databases you wish to analyze in Bl4Dynamics to your

Azure Storage Information

Subscription: Pay-As-You-Go

Resource Group: vm-bid-demo

Storage Account Name: vmbi4demostorageaccount
Container Name: vmbiddemocontainer

Blob Key: vnnvyi7obPZTtcNuPvEMCmT76XViw==

Test Storage Credentials:

Data Source Information

Business Central

Business Central Login: m

BC Tenant ID: 4087c3b3-ce26-4172-8076-b506243¢
App Registration Client ID: 894f8a04-8acc-42c5-8d65-12ca5487;
BC Enviroment Name: El4Dynamics_UK -
BC Sandbox Enviroment Name: Sandbax -

Select BC environment and click Initialize Data Lake. 0

Success * 2 minutes

| Initilization completed!

After Initializing click Add to add the selected data source and wait... @

Your screen should look like this: .
2 minutes

Data sources

123.0, vm-bid-demaivm...

a wm-bid-demo.westeurop...
LY BI4Dynamics BC

You have successfully added data source

Click Next.



1.

From the list of companies tick the ones you want to include in your instance and configure
additional settings for each selected company:
a. Company short name: User-friendly name (e.g. ME)
Country and Local Currency are read from BC (no input).
b. Additional Currency: select the additional currency for this company (e.g. USD);
Transaction values in local currency will be recalculated by exchange rate valid at transaction
date to values in additional currency (ACY). There are few hundred ACY measures.
c. Dimensions:

Click Initialize global dimensions (delete the dimension by clicking the X button next to
the dimension name if one or more dimensions will not be used in the project).
We suggest adding a prefix or suffix (“dim” or “Dim") to global dimension name, so that
» global dimensions are easier to find in the front-end tool (Excel, Power Bl) and
= we have unique name in application (you may have global dimension “Job” which is
also a standard Bl4Dynamics dimension, having two with same name will cause an
error).
Click Add dimension to add the company dimensions and map it to corresponding global
dimension. Mapping is done automatically, but you can manually change it if needed.
Delete the dimension by clicking the X button next to the dimension name
Continue adding and mapping dimensions for other selected companies. Only click Initialize
global dimension if there are additional dimensions that are not present in the first company.

2. Click Next.

Select Companies

All companies

= vm-bi4-demo.westeurope.cloudapp.azure.com/BI4Dynzg
Bl4Dynamics ME

CRONUS UK Ltd.

Company Configuration

Bl4Dynamics ME

Company short name: ||ME

Country: GB

Local Currency: GBP

Additional Currency: EUR =

Select local dimension: Map to global dimensions:

Customer Group ~ | | Customer Group (dim)

Department + | | Department (dim)

-

-

Global Dimensions

Initialize glebal dimension by adding unique
dimension from current company.

Initialize global dimension

1 |Customer Group (dim) n

2 |Department (dim) n
Add dimension




Bl4Dynamics BC Cloud - Installation Manual

2.1.5. Step 5: Selecting Modules

Select Modules you would like to apply to your instance:

1 License Information

2 Mew Instance

3 Add Data Sources

4 Select Companies

5 Select Modules

Select Modules

Standard Application Areas

¥

M e
@ [
“@®
9w
@
o™

FrameworkAzure
General Ledger
Inventory
Payables
Purchase
Receivables

Sales

Click Next.

2.1.6. Step 6: Finishing the setup

In the last step please click Close (do not click Run)

1 License Information Run

2 New Instance
Deploy

3 Add Data Sources Process

4 Select Companies

] Automatic update

[ Auto update MetaData

Page 15

_

5  Select Modules

Deploying...

19-81-2021
19-81-2021
19-81-2021
19-81-2621
19-81-20821
19-81-20821
19-81-2021

19-81-2021

12:@0:

12:56:

12:532:

12:56:

12:58:

12:58:

12:5@:

12:5@:

Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BEI4Dynamics BC\BI4Dy

Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BI4Dynamics BC\BI4Dy

Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BI4Dynamics BC\BI4Dy

Datasource is succcessfully added to datasource collection!

Reading data and loading to program ...

Reading data and loading to program ...

Updating the tables and columns from datasource structure..

Adding data source 'vm-bi4-demo.westeurope.cloudapp.azure.com/BI4Dynamics BC' ..

[[] Show on startup




Open Deploy tab and make sure Keep Data Warehouse and Keep Analysis Database are checked

Al Deploy

[
e~ SoEdit
=0

d

Add SoRemove

Process

Customize

SQL2017
Demo Database NA...

17.0, NPS-GROUP\a...

Data Sources

Stage

-

bess

Install

R
N

Companies Modules

Settings

£{1 Stage
i Data Warehouse

O

De};‘)|I|Oy [ Analysis Database

Deploy Solution

Deploy manual
scripts only

Deploy manual scripts Deploy & Process

o0

Deploy &
Process All

&
&
Setuy|

|| Keep Data Warehouse

Deploy V| Keep Analysis Database

Setup Deploy

Move to Install tab and click Installation button.

i 5 |
Deploy Process Customize Stage Install
[] Auto update " .
rtj @ ) Update from NAV — ?@
Installation Get ® Update from Instance folder  pownload Delete all
MetaData solution scripts
Settings Metadata Download Clear install

On the Installation screen, uncheck #9 Process Instance, click Run

Check Framework module: deployed

Check MetaData: loaded

Get DWA scripts

Deploy Manual Scripts

Load DWA scripts

[/] Generate SQL scripts for Dimensions
Generate SQL scripts for Cubes

Deploy instance

© L N o u AW N

[] Process instance

Select All

Deselect All

Check if Framework module has been deployed in previous steps, if not, deploy Framework
Check if Metadata has been loaded in previous steps, if not, run Get MetaData button

Copy all DWA scripts from cloud to your local instance (folders 1-6) for all modules in the license
Deploy manual scripts in main folders (1, 3, 4 and 5) and subfolder ‘#ManualScripts’

Load DWA scripts from folder 6 to memory

Generate SQL scripts based on dimension models and metadata

Generate SQL scripts based on cube models and metadata

Create SQL data warehouse and cubes

Process data from Microsoft Dynamics to data warehouse and cubes

Installation x

Installation completed

Wait for the “Installation Completed” message.

You have successfully deployed data warehouse and analytics.




2.2. Exporting data from BC to Blob Storage

We want to get table data from BC to data warehouse. The first step is to get data from BC to Blob
Storage. This process is triggered by running Container instance. In installation process now, we will run
the process manually, to immediately get data from BC to Blob Storage. Later, this is triggered by daily
job.

Run Container Instance to export data from BC Cloud to Blob Storage (in Azure portal):

All services » Container instances

Container instances < .- vm-bi4-demo »

BI4DYNAMICS (bi4dynamics.com) Container instances

= New %9¢ Manage view ~  tt |/-" ISea’:k (Ctrl+n | < [> Start

© Overview A Essentials

| Filter for any field... |

Name + E Activitylog Resource group (change]
;)1_ Access control (JAM) status

@ vm-bia-demo 1 Location

€ Tags

Wait until the process is finished. It can take 30 minutes for database with few million records.

You have successfully exported data from BC to Blob Storage

2.3. Processing instance (DW and analytics)

On the Installation screen, please check #9 Process Instance, click Run

1| [] Check Framework module: deployed | Check if Framework module has been deployed in previous steps, if not, deploy Framework

2 | [[] Check MetaData: loaded Check if Metadata has been loaded in previous steps, if not, run Get MetaData button

3| [[] Get DWA scripts Copy all DWA scripts from cloud to your local instance (folders 1-6) for all modules in the license
4[] Deploy Manual Scripts Deploy manual scripts in main folders (1, 3, 4 and 5) and subfolder ‘#ManualScripts

5[] Load DWA scripts Load DWA scripts from folder 6 to memory

6 D Generate SQL scripts for Dimensions | Generate SQL scripts based on dimension models and metadata

7 | [[] Generate SQL scripts for Cubes Generate SQL scripts based on cube models and metadata

8 [[] Deploy instance Create SQL data warehouse and cubes

9 Process instance Process data from Microsoft Dynamics to data warehouse and cubes

Select All Deselect All

Wait for the “Installation Completed” message.

Installation X

__/' b
‘.0' Installation completed
.

You have successfully installed data warehouse and analytics.




When you choose to install analytics as Azure Analysis Services, you need to install following:

- Azure Analysis Service in Azure portal
- On-Premises Gateway on your Bl server

We recommend to first install On-premises Gateway and later Azure Analysis Services as we enter
parameters from on-Premises gateway to Azure Analysis Service settings.

3.1. Installing On-premises Data Gateway

On-premises data gateway is needed when connecting to Azure Analysis Service. This requires two steps:

1. Install On-Premises data gateway on local computer

2. Configure On-Premises data gateway field in Azure Analysis Services by selecting the On-Premises
data gateway

Download On-Premises data gateway to virtual machine
Download On-Premises Data gateway from Microsoft site:
https://www.microsoft.com/en-us/download/details.aspx?id=53127

Install On-premises data gateway
Follow the documentation from Microsoft site:
https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install

Note: Please be very careful when selecting the right region. Installation process will set On-Premises
Gateway to your default region, that may not be the same as Azure Analysis Services. The feature is not
so exposed during installation so it can easily go unnoticed.

Q} On-premises data gateway

You are signed in as mg@bi4dynamics.com and are ready to register the gateway.

New on-premises data gateway name

[ Add to an existing gateway cluster Learn more

Recovery key (8 character minimum)

(1) This key is needed to restore the gateway and can't be changed. Record it in a safe place

Confirm recovery key

‘we'll use this region to connect the gateway to cloud services: North Europe Change Region
Provide relay details By default, Azure Relays are automatically provisionad

If you have set the wrong Region, and your Gateway does not appear in the available list of gateways of
your Azure Analysis Services than you must re-install On-Premises data gateway.


https://www.microsoft.com/en-us/download/details.aspx?id=53127
https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install

Go to Azure portal
Click on icon On-premises Data Gateway

Azure services .
Create connection gateway
+ ¢ 9 e — On-premises data gateway
Create a On-premises Container Analysis Storage
resource Data Gateways instances Services accounts Resource Name *
Click on + New D14-data-gateway /]
On-premises Data Gateways » - Subscription *
BI4DYNAMICS | Pay-as-You-Go v |
- New é.:S} Manage view ~~ C_) Refresh  « Exportto C5V Resource group *
| hid-vm-de v |
. Create new
Enter all fields:
Resource name Location *
T | ramrth Errmme
Subscription lorth Europe v
Resource group Installation Name *
Location P — v|

Installation name: select on-premises gateway that you have
created in previous step from the list of available gateways
Select from availakble installed o
. 0 gateways. For details click here,
Then click Create

Click Go to Resource:

Home
h On-premises Data Gateway
|/':' Search (Ctrl+/) ‘ <« ]E[ Delete
©* On-premises Data Gateway Essentials -~
B Activity log Resource group (change)
vm-bid-demo
An Access control (IAM) Location
Woest Europe
¢ Tags Subscription name (change)
Pay-£ 3

Settings Subscription 1D
Oedf89a6-c40e-475e-99db-92b04d2 14475
E] Locks

Automation

2. Tasks (preview) Services for this gateway

« Export template
Name Status

Suppert + troubleshooting I Logic apps @ Configured

You have successfully created an On-premises Data Gateway as Azure Service.

On-premises Data Gateway must be selected on Azure Service like Azure Analysis Services that will use
this gateway to receive On-premises data.



3.2. Installing Azure Analysis Services

Before installing Bl4Dynamics app you need to have available Azure Analysis Services that will host
Bl4Dynamics database.

Go to Azure portal, find Analysis Services and click +Add

Home

Analysis Services =

BMDYNAMICS

~+ add Edit columns () Refresh
Subscriptions: 2 of 3 selected - Don't see a subscription? Open Directory + Subscription settings
Home > Analysis Services
Analysis Services
Enter the following fields: Analysis Services
- Server name: unique name of Analysis Server |b4dymhyb‘
- Subscription oeenpmon
- Resource group | pay-As-You-Go v
- Location Resource group *
- Pricing tier |””tb‘“”” v ]

Database size (GB) will depend on data type, cardinality, and Location *

number of rows in your data warehouse | Wesueueope v
QPUS (number of processing units) will depend on database size
and number of users that will query the data

Pricing tier (View full pricing details) *

| D1 (20 Query Processing Units) ~ |

Administrator (Select) * (0

| mg@biddynamics.com “ ‘

Suggestion: start with lower tier, check if data can fit into database

R . . Backup Starage Settings
and if response time from your Bl tool (Excel or Power Bl) is good Backup Storage: Not configured ’
enough. If not, go for higher tier. It takes 60 seconds to change tier | _ "~
to next level. [Never v

Click Create

X
(] Deployment succeeded 8:22 AM
Deployment ros AnalysisServices' to resource
group ‘vm-bid-demo’ was successful.

— )
# Pin to dashboard m Automation options

You have successfully created Azure Analysis Services




Go to resource and copy Server name to notepad as it will be used in Bl4Dynamics app installation.

2a biddynamicshybrid  »

Analysis Services
|,"3" }Sea’ch (Ctrl+/) | « | Newmodel || Pause — Move [i] Delete
&= Qverview Essentials
@ Activity log Resource group (change) Server name
vm o asazure://westeurope.asazure.windows.net/biddynamicshybrid
Ao Access control (IAM) Status erver Name
Active //westeurope.asazure.windows.net/biddynamicshybrid:rw
¢ Tags Location Pricing tier

West Europe D1
;‘ Diagnose and solve problems P

Scale

7. Pricing Tier (Scale QPUs)

7 Replicas

Models on Analysis Services Server

Models

@ Manage Name Compatibility Date Modified Last Synced Time Sync State
Sett No results

ettings

é} Quick Start

In our example server name is: asazure://westeurope.asazure.windows.net/bi4dynamicshybrid

To verify installation, connect to Analysis Services Server use SSMS (SQL Server Management Studio)
and enter:

Server Type: Analysis Services

Server name

Authentication: Azure Active Directory

Username

Password

Here is a database that we have just created:

Object Explorer 1
Connect~ ¥ *§ (VIS

2 asazure://westeurope.asazure.windows.net/biddynamicshybrid (Microsoft Analysis Server 15.1.76.24 - mg@biddynamics.com)
= Databases
= | Bl4Dynamics BC OnPremise Hybrid
Connections

3 Tables
£3 Roles
& Management

oF Connect to Server X

SQL Server

Server type: Analysis Services ~

Server name |asazure.//westeurupe.asazure.wmduws net/biddynamicst |

Authentication: Azure Active Directory - Password ~
User name: |mg@b|4dynam|cs com v |
Password: | .................... ] |

[] Remember password

Cancel Help Options 5>




On-Premises Data Gateway is needed when Azure Service received data from On-Premises. When Azure
Analysis Services is receiving data from On-Premises source than this option must be selected.

Click on On-premises data gateway
And Pick an On-Premises Data Gateway to connect

%, biddynamicshybrid | On-Premises Data Gateway

Analysis Services

v

|/-7J Search (Ctrl+/) ‘ 3 : lected gateway

&= Overview . ~
Analysis Services Region

& Activity log MNorth Europe

Ao Access control (1AM)
Gateway Region

¢ Tags F—

Diagnose and solve problems ) -
ﬁ = P Pick an On-Premises Data Gateway to connect: ()

Scale

/. Pricing Tier {(Scale QPUs)
7 Replicas

Models

B Manage

Settings

é; Quick Start

R analysis Services Admins
W Cn-Tremises Data Gataws,
& Backups

& Connection Strings
g

Click Connect selected gateway.

Gateway is now connected:

% biddynamicshybrid | On-Premises Data Gateway

.:nal;-'s 5 JEMVICES

|/fJ Search (Ctrl+/) | < ;5«6 Disconnect gateway

&= Overview i R ]
Analysis Services Region

@ Activity log North Europe

'CR Access control (IAM)

Gateway Region

¢ Tags North Europe

/2 Diagnose and solve problems < Flte i

scale bid-data-gateway

4 Pricing Tier (Scale QPUs)




3.3. Creating Instance

Instance properties
Source is BC Cloud (SaaS):
Instance Name: Bl4Dynamics BC OnPremise
Language: English (United States) -
SQL Server Analysis Services
Database Name: BI4Dynamics BC OnPremise Hybrid Analysis Database Name: Bl4Dynamics BC OnPremise Hybrid
SQL Server Name: MLADENNUC\EC hé Analysis Server Name: asazure://westeurope.asazurewir ¥
Authentication: Windows e Authentication: Azure Active Directory -
Username: NPS-GROUP\mgvozden Username: mg@biddynamics.com
Password sssssssssses Password: sassssssasssnssssase
Analysis Server Option: Tabular -
Mode type: Import -

Instance properties

1. Check the Source is BC Cloud checkbox.
2. Type the Name of the new instance.
3. Select what Language the solution will be deployed in

SQL server
As we are moving Analytics to Azure, we also need to move credential information to Azure Analysis

Services. Authentication for SQL server will be saved to Azure Analysis Services string connection as
Account impersonation.

When choosing Azure Active Directory in Analysis Services setup, a new Authentication window will open
for SQL Server. Please enter:

e Username: same user in DOMAIN\adminuser format
e Password: password for this user

Analysis Services

e Check the Source is BC Cloud checkbox.
e Analysis Server name: enter the name of the Azure Analysis Services
Authentication: Azure Active Directory
Username: email of the admin user (adminuser@domain.com) that has been entered when creating
Azure Analysis Services
Password: enter password for Azure Active Directory

This is the current setting on the form, and we continue with installation:


mailto:adminuser@domain.com

Integration Services e
Check SQL Integration Service to process Bl4Dynamics |« ===

Instance Name:

using the Integration services (parallel processing). .
Refresh Q —
Click Refresh to set default values for SQL Database |-

file Locations (data and log files) and SQL Database

e Hybrd Anziysis Database Name:

Name

Windew

Collation are entered automatically. Modify if
necessary.

Test

Please note that

- VM is for installation on of Azure SQL VM
- Local is for local server installation
We are testing more resources on VM than on Local.

Click VM or Local to test resources that must be installed on VM or Local Machine to proceed with BC
installation. Diagnostics message should confirm that all resources are available, set and running. In case
any of these shows ERROR, stop BC installation and fix the reported service error. This should be the
message:

Diagnostics x

& Polybase: Running
QW' Polybase enabled: Ok
Hadaap Connectivity enabled: OK

Azure CLI Check: OK
Azure CLI Check: v.2.19.1

Continue and click Refresh to update file locations
Click Next.




Azure Storage Information
This information is about Azure Storage Account that will be used to keep BC data. The values have
been created during VM installation and are listed as a prerequisite for BC application installation.

Type Subscription that is used for Storage Account

Type Virtual Machine Resource Group as VM Resource Group

Type Storage Account Name

Type Container Name (this resource should not be confused for Container instance aca Docker,
that is another Azure resource, used for exporting tables to Storage Account)

5. Type Blob Key

Click Test to check if the entered information is correct.

Hwn =

License Information Add Data Sources

CRteulinsEnce Add all NAV source databases you wish to analyze in Bl4Dynamics to your Bl4Dynamics instance.

3 Add Data Sources Azure Storage Information

Subscription: Pay-As-You-Go

VM Rescurce Group: vm-bid-demo

Storage Account Name: vmbiddemostorageaccount
Container Name: vmbiddemocontainer

Blob Key: $504Gr1dCLgciaxFY0AGOaThFgyFVpé

Test Storage Credentials:

Click Test to test entered information.
A new window will require authentication. Enter Azure portal admin user and password:

B Adm ator: C:\wind

B¥ Microsoft

Sign in

[mail, phone, or Skype

No account? Create one!

Can't access your account?

EX Administrator: Ciwindows\System32\WindowsPowerShell\v1.0\powershell.exe - m]

Untrusted repository
You are installing the modules from an untrusted repository. If you trust this repository, change its
InstallationPolicy value by running the Set-PSRepository cmdlet. Are you sure you want to install the modules from
'PSGallery'?

[¥] ves [A] ves to All [N] No [L] No to All [S] Suspend [?] Help (default is "N"):

Wait few minutes to start downloading and installing packages

E¥ Administrator: Cwindows\System32\WindowsPowerShell\wl.0\powershell.exe

Intrusted repository

Installing package 'Az’
Installing dependent package 'Az.Resources’
[000000000000000000000000000000000000000000000000C0000000000000 H
Installing package 'Az.Resources' 2 mlnutes
Process Package Manifest
[000000000000000000000000000000000000000000000000000000000000

On finish this message pop-us to confirm that resources are entered correctly:

Bl4 Diagnostics X

i FResource Group: OK
J) storage Account: OK
Storage Container: OK




Business Central
Click Login to login into Azure with BC admin credentials.

Add Data Sources

Add all NAV source databases you wish to analyze in Bl4Dynamics {]

Azure Storage Information

Subscription: Pay-As-You-Go

Resource Group: wm-hid-demo

Storage Account Name: vmbiddemostorageaccount
Container Name: vmbiddemocantainer

EBlob Key: iy TobPZTteNuPYEMCm76XVw==

Test Storage Credentials:

Data Source Information

Business Central

Business Central Login:
BC Tenant ID:

App Registration Client 1D:
BC Enviroment Name: &7

BC Sandbox Enviroment Name: h

Initialize Data Lake

A new window will open:

‘(l‘eating the AAD application BI4

B Microsoft
Sign in

|Er"vawl‘ phone, or Skype

No account? Create one!
Can't access your account?

Sign-in options

Enter username and password for BC admin (first time)

After entering password wait 15 seconds to sign in again. In this process, BC admin will allow Bl4Dynamics
application to access BC data. Enter BC admin credentials (second time):

Sometimes, account login does not work correctly. Use option Use another account and enter the same
BC admin account credentials.

B® Microsoft

Pick an account

|z| admin.user@biddynamics.onmicrosoft.com

john.smith@bi4dynamics.com

—|— Use another account

Back




New window will pop-up:

B Microsoft
dev@bidd.onmicrosoft.com

Permissions requested

Bl4
{App Infol

This app would like to:

~ Sign you in and read your profile

Does this app look suspicious? Repart it here

Cancel

This application is not published by Microsoft.

v Have full access to Dynamics 365 Business Central

Accepting these permissions means that you allow this app to use your
data as specified in their terms of service and privacy statement. ¥
change these permissions at https://myapps.microsoft.com. S

ow details

Click Accept and wait ...

Application will automatically fill-in BC Tenant ID and App Registration Client ID:

1 minute

(You can enter this information if you have it from previous process without login process)

Add Data Sources

Add all NAV source databases

Subscription:

Resource Group:
Storage Account Name:
Container Name:

Blob Key:

Test Storage Credentials:

Data Source Information

Business Central
Business Central Login:

BC Tenant ICx

App Registration Client ID:
BC Enviroment Name:

BC Sandbox Enviroment Name:

you wish to analyze in Bl4Dynamics to your|

Azure Storage Information

Pay-As-You-Go
vm-bid-demo
vmbiddemostorageaccount
vmbiddemocontainer

ynnvyi7obPZTteNuPvEmCm7eX V==

4087¢3b3-ce26-417e-8076-b5062434
894f8a04-Bacc-42c5-8d65-12ca5487]
Bl4Dynamics_UK -

Sandbox =2

Select BC environment and click Initialize Data Lake.

Success X

| Initilization completed!

2 minutes



After Initializing click Add to add the selected data source and wait... ©®

Your screen should look like this: .
2 minutes
Data sources

a wvm-bid-demo.westeurop...
LY Bl4Dynamics BC
e

123.0, vm-bid-demcivm...

You have successfully added data source

Click Next.



3. From the list of companies tick the ones you want to include in your instance and configure
additional settings for each selected company:

a. Company short name: User-friendly name (e.g. ME)
Country and Local Currency are read from BC (no input).

b. Additional Currency: select the additional currency for this company (e.g. USD);
Transaction values in local currency will be recalculated by exchange rate valid at transaction
date to values in additional currency (ACY). There are few hundred ACY measures.

c. Dimensions:

Click Initialize global dimensions (delete the dimension by clicking the X button next to
the dimension name if one or more dimensions will not be used in the project).
We suggest adding a prefix or suffix (“dim” or “Dim") to global dimension name, so that
» global dimensions are easier to find in the front-end tool (Excel, Power Bl) and
= we have unique name in application (you may have global dimension “Job” which is
also a standard Bl4Dynamics dimension, having two with same name will cause an
error).
Click Add dimension to add the company dimensions and map it to corresponding global
dimension. Mapping is done automatically, but you can manually change it if needed.
Delete the dimension by clicking the X button next to the dimension name
Continue adding and mapping dimensions for other selected companies. Only click Initialize
global dimension if there are additional dimensions that are not present in the first company.

4. Click Next.

Select Companies

All companies

= vm-bi4-demo.westeurope.cloudapp.azure.com/BI4Dynzg
Bl4Dynamics ME

CRONUS UK Ltd.

Company Configuration

Bl4Dynamics ME

Company short name: ||ME

Country: GB

Local Currency: GBP

Additional Currency: EUR =

Select local dimension: Map to global dimensions:

Customer Group ~ | | Customer Group (dim)

Department + | | Department (dim)

-

-

Global Dimensions

Initialize glebal dimension by adding unique
dimension from current company.

Initialize global dimension

1 |Customer Group (dim) n

2 |Department (dim) n
Add dimension




Bl4Dynamics BC Cloud - Installation Manual

3.3.5. Step 5: Selecting Modules

Select Modules you would like to apply to your instance:

License Information Select Modules

MNew Instance

Standard Application Areas
Add Data Sources

-* FrameworkAzure
Select Companies ™~ General Ledger
E Inventory
Payables
E Purchase
@ Receivables
ﬂ Sales

Select Modules

Click Next.

3.3.6. Step 6: Finishing the setup

In the last step please click Close (do not click Run)

1 License Information Run

2 New Instance
Deploy

3 Add Data Sources Process

4 Select Companies

] Automatic update

] Auto update MetaData

Page 30

Instance Wizard X

5 Select Modules .
Deploying...

m Q 19-81-20821 12:08:13 Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BEI4Dynamics BC\BI4Dy
o 19-81-2821 12:56:17 Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BI4Dynamics BC\BI4Dy
o 19-81-2821 12:52:48 Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BI4Dynamics BC\BI4Dy
o 19-81-2021 12:58:11 Datasource is succcessfully added to datasource collection!
o 19-81-20821 12:58:11 Reading data and loading to program ...
o 19-91-2821 12:58:1@ Reading data and loading to program ...
0 19-81-2021 12:50:10 Updating the tables and columns frem datasource structure..
0 19-91-2021 12:58:1@ Adding data source 'vm-bi4-demo.westeurope.cloudapp.azure.com/BI4Dynamics BC' ..
-

[] Show on startup




Open Deploy tab and make sure Keep Data Warehouse and Keep Analysis Database are checked

Al Deploy

[
e~ SoEdit
=0

d

Add SoRemove

Process

Customize

SQL2017
Demo Database NA...

17.0, NPS-GROUP\a...

Data Sources

Stage

-

bess

Install

R
N

Companies Modules

Settings

£{1 Stage
i Data Warehouse

O

De};‘)|I|Oy [ Analysis Database

Deploy Solution

Deploy manual
scripts only

Deploy manual scripts Deploy & Process

o0

Deploy &
Process All

&
&
Setuy|

|| Keep Data Warehouse

Deploy V| Keep Analysis Database

Setup Deploy

Move to Install tab and click Installation button.

i 5 |
Deploy Process Customize Stage Install
[] Auto update " .
rtj @ ) Update from NAV — ?@
Installation Get ® Update from Instance folder  pownload Delete all
MetaData solution scripts
Settings Metadata Download Clear install

On the Installation screen, uncheck #9 Process Instance, click Run

Check Framework module: deployed

Check MetaData: loaded

Get DWA scripts

Deploy Manual Scripts

Load DWA scripts

[/] Generate SQL scripts for Dimensions
Generate SQL scripts for Cubes

Deploy instance

© L N o u AW N

[] Process instance

Select All

Deselect All

Check if Framework module has been deployed in previous steps, if not, deploy Framework
Check if Metadata has been loaded in previous steps, if not, run Get MetaData button

Copy all DWA scripts from cloud to your local instance (folders 1-6) for all modules in the license
Deploy manual scripts in main folders (1, 3, 4 and 5) and subfolder ‘#ManualScripts’

Load DWA scripts from folder 6 to memory

Generate SQL scripts based on dimension models and metadata

Generate SQL scripts based on cube models and metadata

Create SQL data warehouse and cubes

Process data from Microsoft Dynamics to data warehouse and cubes

Installation x

Installation completed

Wait for the “Installation Completed” message.

You have successfully deployed data warehouse and analytics.




3.4. Exporting data from BC to Blob Storage

We want to get table data from BC to data warehouse. The first step is to get data from BC to Blob
Storage. This process is triggered by running Container instance. In installation process now, we will run
the process manually, to immediately get data from BC to Blob Storage. Later, this is triggered by daily
job.

Run Container Instance to export data from BC Cloud to Blob Storage (in Azure portal):

All services » Container instances
Container instances < .- vm-bi4-demo #
BI4DYNAMICS (bi4dynamics.com) Container instances

= New %9¢ Manage view ~  tt |/-" ISea’:k (Ctrl+n | < [> Start

- Overvi A Essentials
| Filter for any field... | 7 GUERED
ity Resource group (change]
Name T B Activity log group (chang
Ao Access control (IAM) status

@ vm-bia-demo 1 Location

€ Tags

Wait until the process is finished. It can take 30 minutes for database with few million records.

You have successfully exported data from BC to Blob Storage

3.5. Processing instance (DW and analytics)

On the Installation screen, please check #9 Process Instance, click Run

1 Check Framework module: deployed | Check if Framework module has been deployed in previous steps, if not, deploy Framework

2 Check MetaData: loaded Check if Metadata has been loaded in previous steps, if not, run Get MetaData button

3 Get DWA scripts Copy all DWA scripts from cloud to your local instance (folders 1-6) for all modules in the license
4 Deploy Manual Scripts Deploy manual scripts in main folders (1, 3, 4 and 5) and subfolder “#ManualScripts’

5 Load DWA scripts Load DWA scripts from folder 6 to memory

6 Generate SQL scripts for Dimensions | Generate SQL scripts based on dimension models and metadata

7 Generate SQL scripts for Cubes Generate SQL scripts based on cube models and metadata

8 Deploy instance Create SQL data warehouse and cubes

9 [] Process instance Process data from Microsoft Dynamics to data warehouse and cubes

Select All Deselect All

Wait for the “Installation Completed” message.

Installation X

' Installation completed

You have successfully installed data warehouse and analytics.




4.1. Installing On-premises Data Gateway

Download On-Premises data gateway to virtual machine
Download On-Premises Data gateway from Microsoft site:
https://www.microsoft.com/en-us/download/details.aspx?id=53127

Install On-premises data gateway
Follow the documentation from Microsoft site:
https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install

Note: Please be very careful when selecting the right region. Installation process will set On-Premises
Gateway to your default region that may not be the same as Azure Analysis Services. The feature is not
so exposed during installation so it can easily go unnoticed.

Cf) On-premises data gateway

You are signed in as mg@bi4dynamics.com and are ready to register the gateway.

Mew on-premises data gateway name

[] Add to an existing gateway cluster Learn more

Recovery key (8 character minimum)

(1) This key is needed to restore the gateway and can't be changed. Record it in a safe place.

Confirm recovery key

‘We'll use this region to connect the gateway to cloud services: North Europe Change Region
Provide relay details By default, Azure Relays are automatically provisioned

If you have set the wrong Region, and your Gateway does not appear in the available list of gateways of
your Azure Analysis Services than you must re-install On-Premises data gateway.


https://www.microsoft.com/en-us/download/details.aspx?id=53127
https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install

4.2. Creating Power Bl workspace

1. Open Power BI portal, press Workspaces and Create a workspace.

Power Bl Bl4Dynamics PPU TEST

My workspace

t Home

Q search
3¢ Favorites >
Workspaces

>
© Recent E Bl4Dynamics - Mobile

f

Create

Datasets

Goals

Apps

x H K3 O

Shared with me

0_,§

Deployment pipelines

=
=

Learn

Workspaces

[—
O
[y
Y
N

Create a workspace
/1 Getdata

2. Name the workspace and select Premium per user under License mode.

Create a workspace

Workspace image

Upload

Workspace name

Bl4Dynamics PP

Available

Description

Describe this workspace

Learn more about workspace 3Gﬁl"gé

Advanced ~
Contact list
(® Workspace admins

") Specific users and groups

Workspace OneDrive
Optional)

License mode
Pro

(®) Premium per user

Save Cancel




3. Navigate to your Workspace.

I My workspace l

(@ Home

Y& Favorites
Workspaces
D) Recent y
= E 814Dynamics - Mobile
=+ Create Zx
Bl4Dynamics PPU TEST K
B Datasets
2 Goals
B Apps
& Shared with me
<« D - + - n
57 Deployment pipelines
@ Learn

2@ Workspaces

BI4Dynamics PP.. §& v

4. Press Settings button.

Bl4Dynamics PPU TEST ¢ Create app

[  Name Type Owner Refroshed Next refresh Endorsement Sensitivity Include in app

5. Select Premium tab and Premium per user option and copy Workspace Connection.
Link should look like that: powerbi://api.powerbi.com/v1.0/myorg/Bl4Dynamics%20PPU%20TEST

@ Settings

Bl4Dynamics PPU TEST

About Premium Azure connections

License mode

Pro
Fro

(® Premium per user

Default storage format

dataset storage format s

Learn more about dataset storage formats

Works space Connection

//api.powerbi.com/v1.0/myorg/Bl4Dynamics%20PPU%20TEST

Copy
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4.3. Creating Instance

New Instance

Instance properties

Source is BC Cloud (SaaS):

Instance Name:
Language:

SQL Server
Database Name:
SQL Server Name:

Authentication:

v

814Dynamics BC

English (United States)

Bl4Dynamics BC
ALEXW10

Windows

Analysis Services

Analysis Database Name:

Analysis Server Option:

Workspace:

Authentication:
Username:

Password:

Mode type:

Bl4Dynamics BC

Power 81 (XMLA endpoint) -
9/Bl4Dynamics%20XML3%20endpoint
Azure Active Directory v
powerbi®biddynamics.com

..... eessesesecscene

Import -

Instance properties

1. Check the Source is BC Cloud checkbox.
2. Type the Name of the new instance.

3. Select what Language the solution will be deployed in

SQL server

e SQL Server Name: name of the server DW will be installed on

Authentication: Windows
Analysis Services

e Check the Source is BC Cloud checkbox.
e Analysis Server Option: Power Bl (XMLA endpoint)

Workspace: connection link to the Power Bl workspace that you have created in the previous steps

Authentication: Azure Active Directory

Username: Power Bl Premium user email (adminuser@domain.com)

Password: password for Azure Active Directory

This is the current setting on the form, and we continue
with installation:

Integration Services

Check SQL Integration Service to process Bl4Dynamics
using the Integration services (parallel processing).
Refresh

Click Refresh to set default values for SQL Database file

Locations (data and log files) and SQL Database Collation are entered automatically. Modify if

necessary.
Test
Please note that

- VM is for installation on of Azure SQL VM
- Local is for local server installation

We are testing more resources on VM than on Local.

Language: Englich (United Seates)

SQL Server

Database Name B4y mamics &



mailto:adminuser@domain.com

Click VM or Local to test resources that must be installed on VM or Local Machine to proceed with BC
installation. Diagnostics message should confirm that all resources are available, set and running. In case
any of these shows ERROR, stop BC installation and fix the reported service error. This should be the
message:

Diagnostics x

A% Polybase: Running
W' rolybase enabled: OK
= Hadoop Connedtivity enabled: OK

Azure CLI Check: OK
Azure CLI Check: v.2.19.1

Continue and click Refresh to update file locations
Click Next.

Azure Storage Information
This information is about Azure Storage Account that will be used to keep BC data. The values have
been created during VM installation and are listed as a prerequisite for BC application installation.

Type Subscription that is used for Storage Account

Type Virtual Machine Resource Group as VM Resource Group

Type Storage Account Name

Type Container Name (this resource should not be confused for Container instance aca Docker,
that is another Azure resource, used for exporting tables to Storage Account)

5. Type Blob Key

Click Test to check if the entered information is correct.

Hwn =

License Information Add Data Sources

2 New Instance .
winsta Add all NAV source databases you wish to analyze in Bl4Dynamics to your Bl4Dynamics instance.

Azure Storage Information

Subscription: Pay-As-You-Go

VM Resource Group: vm-bi4-demo

Storage Account Mame: vmbiddemostorageaccount
Container Name: wvmbiddemocontainer

Blob Key: Ss04Gr1dCLgciaxFY0AGOaThFgyFVpe

Test Storage Credentials:

Click Test to test entered information.
A new window will require authentication. Enter Azure portal admin user and password:

Creating the AAD application BI4

B8 Microsoft

Sign in

[Email, phone, or Skype

EX Administrator: Cwindows\System32\WindowsPowerShell\v1.0\powershell.exe - [m]

Untrusted repository
You are installing the modules from an untrusted repository. If you trust this repository, change its
InstallationPolicy value by running the Set-PSRepository cmdlet. Are you sure you want to install the modules from

'PsGallery'?
[¥] ves [A] ves to All [N] No [L] No to All [S] Suspend [?] Help (default is "N"):




Wait few minutes to start downloading and installing packages

EX Administrator: C:\windows\System32\WindowsPowerShell\w1.0\powershell.exe

Jntrusted repository

Installing package ‘Az’
Installing dependent package 'Az.Resources’

[00000000000000000000000000000000000000000000000000000000000000

Installing package 'Az.Resources’ 2 mlnutes

Process Package Manifest
[000000000000000000000000000000000000000000000000000000000000

On finish this message pop-us to confirm that resources are entered correctly:

Bl4 Diagnostics X

& Resource Group: OK
/.' Storage Account: OK
Storage Container: OK

Business Central
Click Login to login into Azure with BC admin credentials.

Add Data Sources

Add all NAV source databases you wish to analyze in Bl4Dynamics {]

Azure Storage Information

Subscription: Pay-As-You-Go

Resource Group: vm-bid-demo

Storage Account Name: vmbiddemostorageaccount
Container Name: vmbiddemocontainer

Blob Key: ynmvyi7obPZTteNuPYEMCmTEXVw==

Test Storage Credentials:

Data Source Information

Business Central

Business Central Login:

BC Tenant ID:
App Registration Client ID:
BC Enviroment Name: =

BC Sandbox Enviroment Name: -

Initialize Data Lake

A new window will open:
E-:“‘,'z'c C ndows\System32\WindowsPowerShel D\powershell.exe
ICreating the AAD application BI4

B® Microsoft

Sign in

tmawl‘ phone, or Skype

No account? Create one!
Can't access your account?

Sign-in aptions

Enter username and password for BC admin (first time)

After entering password wait 15 seconds to sign in again. In this process, BC admin will allow Bl4Dynamics
application to access BC data. Enter BC admin credentials (second time):



Sometimes, account login does not work correctly. Use option Use another account and enter the same
BC admin account credentials.

B® Microsoft

Pick an account

EI admin_user@bi4dynamics onmicrosoft. com
El john.smith@bi4dynamics.com

+ Use another account

Back

New window will pop-up:

B Microsoft
dev@bidd.onmicrosoft.com

Permissions requested

B4 ..

App info!

This application is not published by Microsoft.

This app would like to:

~ Have full access to Dynamics 365 Business Central

~ Sign you in and read your profile

Accepting these permissions means that you allow this app to use your

data as specified in their terms of service and privacy statement. You can
change these permissions at https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here (o)

1 minute
Click Accept and wait ...

Application will automatically fill-in BC Tenant ID and App Registration Client ID:
(You can enter this information if you have it from previous process without login process)

Add Data Sources

Add all NAV source databases you wish to analyze in Bl4Dynamics to your

Azure Storage Information

Subscription: Pay-As-You-Go

Resource Group: vm-bid-demo

Storage Account Name: vmbi4demostorageaccount
Container Name: vmbiddemocontainer

Blob Key: vnnvyi7obPZTtcNuPvEMCmT76XViw==

Test Storage Credentials:

Data Source Information

Business Central

Business Central Login: m

BC Tenant ID: 4087c3b3-ce26-4172-8076-b506e43¢
App Registration Client ID: 894f8a04-8acc-42c5-8d65-12ca5487;
BC Enviroment Name: El4Dynamics_UK -
BC Sandbox Enviroment Name: Sandbax -




Select BC environment and click Initialize Data Lake. ®

Success e G 2 m|nute5
:/- .\:] Initilization completed!

After Initializing click Add to add the selected data source and wait... <
Your screen should look like this:

0 2 minutes
Data sources

g wm-bid-demo.westeurop...
ﬁ El4Dynamics BC
b 123.0, vm-bid-demoivm...

You have successfully added data source

Click Next.



5. From the list of companies tick the ones you want to include in your instance and configure
additional settings for each selected company:

a. Company short name: User-friendly name (e.g. ME)
Country and Local Currency are read from BC (no input).

b. Additional Currency: select the additional currency for this company (e.g. USD);
Transaction values in local currency will be recalculated by exchange rate valid at transaction
date to values in additional currency (ACY). There are few hundred ACY measures.

c. Dimensions:

Click Initialize global dimensions (delete the dimension by clicking the X button next to
the dimension name if one or more dimensions will not be used in the project).
We suggest adding a prefix or suffix (“dim” or “Dim") to global dimension name, so that
» global dimensions are easier to find in the front-end tool (Excel, Power Bl) and
= we have unique name in application (you may have global dimension “Job” which is
also a standard Bl4Dynamics dimension, having two with same name will cause an
error).
Click Add dimension to add the company dimensions and map it to corresponding global
dimension. Mapping is done automatically, but you can manually change it if needed.
Delete the dimension by clicking the X button next to the dimension name
Continue adding and mapping dimensions for other selected companies. Only click Initialize
global dimension if there are additional dimensions that are not present in the first company.

6. Click Next.

Select Companies

All companies Company Configuration Global Dimensions
- Bl4Dynamics ME Initialize global dimension by adding unique
dimension from current company.
= vm-bi4-demo.westeurope.cloudapp.azure.com/BI4Dynzg Company short name: ||ME
Bl4Dynamics ME Country: GB Initialize global dimension
Local Currency: GBP n
A 3 1 |Customer Group (dim)
CRONUS UK Ltd. Additional Currency: EUR = P
2 |Department (dim) n
Select local dimension: Map to global dimensions: Add dimension
Customer Group ~ | | Customer Group (dim) -

Department + | | Department (dim) - n
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4.3.5. Step 5: Selecting Modules

Select Modules you would like to apply to your instance:

1 License Information Select Modules

2 New Instance

Standard Application Areas
3 Add Data Sources
FrameworkAzure

4 Select Companies General Ledger

Inventary

5  Select Modules
Payables
Purchase
Receivables
Sales

Click Next.

4.3.6. Step 6: Finishing the setup

In the last step please click Close (do not click Run)

1 License Information Run

2 New Instance
Deploy
3 Add Data Sources Process

: [ Auto update MetaData
4 Select Companies =

[1 Automatic update

5 Select Modules )
Deploying...

m @ 19-01-2021 13:00:13  Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BI4Dynamics BC\BI4Dy
@ 19-01-2021 12:56:17  Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BI4Dynamics BC\BI4Dy I
@ 19-01-2021 12:52:40  Instance is saved to C:\Program Files (x86)\BI4Dynamics NAV\BI4Dynamics BC\BI4Dy
@ 19-01-2021 12:50:11  Datasource is succcessfully added to datasource collection!
@ 19-01-2021 12:50:11  Reading data and loading to program ...
@ 19-01-2021 12:50:10  Reading data and loading to program ...
@ 19-01-2021 12:50:10  Updating the tables and columns from datasource structure..
@ 19-01-2021 12:50:10  Adding data source 'vm-bi4-demo.westeurope.cloudapp.azure.con/BI4Dynamics BC' ..
-

O s <3 EE e




Open Deploy tab and make sure Keep Data Warehouse and Keep Analysis Database are checked

Al Deploy

[
e~ SoEdit
=0

d

Add SoRemove

Process

Customize

SQL2017
Demo Database NA...

17.0, NPS-GROUP\a...

Data Sources

Stage

-

bess

Install

R
N

Companies Modules

Settings

£{1 Stage
i Data Warehouse

O

De};‘)|I|Oy [ Analysis Database

Deploy Solution

Deploy manual
scripts only

Deploy manual scripts Deploy & Process

o0

Deploy &
Process All

&
&
Setuy|

|| Keep Data Warehouse

Deploy V| Keep Analysis Database

Setup Deploy

Move to Install tab and click Installation button.

i 5 |
Deploy Process Customize Stage Install
[] Auto update " .
rtj @ ) Update from NAV — ?@
Installation Get ® Update from Instance folder  pownload Delete all
MetaData solution scripts
Settings Metadata Download Clear install

On the Installation screen, uncheck #9 Process Instance, click Run

Check Framework module: deployed

Check MetaData: loaded

Get DWA scripts

Deploy Manual Scripts

Load DWA scripts

[/] Generate SQL scripts for Dimensions
Generate SQL scripts for Cubes

Deploy instance

© L N o u AW N

[] Process instance

Select All

Deselect All

Check if Framework module has been deployed in previous steps, if not, deploy Framework
Check if Metadata has been loaded in previous steps, if not, run Get MetaData button

Copy all DWA scripts from cloud to your local instance (folders 1-6) for all modules in the license
Deploy manual scripts in main folders (1, 3, 4 and 5) and subfolder ‘#ManualScripts’

Load DWA scripts from folder 6 to memory

Generate SQL scripts based on dimension models and metadata

Generate SQL scripts based on cube models and metadata

Create SQL data warehouse and cubes

Process data from Microsoft Dynamics to data warehouse and cubes

Installation x

Installation completed

Wait for the “Installation Completed” message.

You have successfully deployed data warehouse and analytics.




4.4. Exporting data from BC to Blob Storage

We want to get table data from BC to data warehouse. The first step is to get data from BC to Blob
Storage. This process is triggered by running Container instance. In installation process now, we will run
the process manually, to immediately get data from BC to Blob Storage. Later, this is triggered by daily
job.

Run Container Instance to export data from BC Cloud to Blob Storage (in Azure portal):

All services » Container instances
Container instances < .- vm-bi4-demo = -
BI4DYNAMICS (bi4dynamics.com) Container instances
T~ New 12% Manage view v =** |/-" ISes’:k (Ctrl+ | « [> Start
£ Overview /. Essentials
| Filter for any field... | @ ov
A ctivity Resource group (change!
MName T W Activity log group (chang
;)1_ Access control (JAM) status
@ vm-bia-demo 1 Location

€ Tags

Wait until the process is finished. It can take 30 minutes for database with few million records.

You have successfully exported data from BC to Blob Storage




4.5. Setup On-Premises Data Gateway

Open SQL Server Management Studio and connect to Power Bl workspace. Newly created analysis
database should have tables, which are currently still empty, since data is not yet processed.

> i://api.powerbi.com/v1.0/myorg/Bl4Dynamics%20PPU%20TES
= Databases
= | J Bl4Dynamics BC PPU
o Connections
= Tables
7 Bill To Customer
=7 Buy From Vendor
7 Common Measures
77 Company
7 Currency
=7 Customer Posting Group
7 Date
77 Document Customer
77 Document Purchase
! Document Purchase Order

Connect to local Database SQL server to check that instance database has been created.
Y L0010 QL server 5047382 NP GROUPle]

(=] Databases

) System Databases
B Database Snapshots
= @ Bl4Dynamics BC PPU
£ Database Diagrams
Tables
System Tables
FileTables
External Tables
Graph Tables
| B dim.Company
ER dim.Currency
] BB dim.Customer
EH dim.CustomerPostingGroup
@ FEH dim.Date
EH dim.DateTool
) BB dim.Dimension1

FEFEEEEEEEE

The next step is to add this database as datasource.
To do that open Power Bl portal Settings and navigate to Manage gateways.

Manage group storage
Create app
Admin portal
= View - Y Filters  £%% 5 Manage gateways Search
Settings
Manage embed codes
Choose option Data Sources and press +New.
= =+ New () Get help
it Home
T Create
B Browse Data (preview)
B Datahub .
Data sources On-premises data gateways Virtual network data gateways

Then fill in the following:

e Choose Gateway cluster name (created during installation of On-premises data gateway)



e Specify the Database and Data Source names (in our case they are the same for simplicity)
e Choose Data Source Type as SQL Server

e Specify your local Server name

e Enter Authentication method as Windows and insert your credentials

e C(lick Create

New data source K

Gateway cluster name *

| ALEXW10 |

Data source name *

| Bl4Dynamics BC PPU |

Data source type *

| SQL Server |

Server *

| ALEXW10 |

Database *

| Bl4Dynamics BC PPU |

Authentication (D)

Authentication method *

| Windows |

Username *

nps-group\alex

Password *

D Skip test connection

Single sign-on
D Use 550 via Kerberos for DirectQuery queries (D)

D Use 550 via Kerberos for DirectQuery and o
Import queries

(O]

Create ‘ Cancel ‘

Make sure that connection was established successfully.

Relate Power Bl database with gateway datasource. To do that navigate to your workspace.

|

Workspaces

/) Recent 4 = o
E BldDynamics - Mobile

Bl4Dynamics PPU TEST b

& Shared with me
5 Deployment pipelines

[ team

@  Workspaces

BI4Dynamics PP




Press three-dot sign and select Settings from the pop-up menu

All Content Datasets + dataflows Datamarts (Preview)

] MName Type Owner
E Bl4Dynamics BC PPU f_:i- s’] =CO Dataset Bl4Dynamics PPU TEST
Analyze in Excel
Create report
Auto-create report
Create paginated report
Create formatted table
Delete
Get quick insights
Security
Rename
Settings
Download this file
Manzge permissions

View lineage

Under Gateway connection select the gateway you have installed on your computer and map gateway
to the datasource used, then click Apply.
General Alerts Subscriptions  Dashboards Workbooks Reports  Dataflows App

Gateway Department Contact information  Status Actions
@  (§D ALEXW10_POWERB! powerbi@biddynamics & -

Data sources included in this datasst:

er""alexw10", database":"biddynamics




4.6. Processing instance (DW and analytics)

Open Bl4Dynamics application and move to Install tab and click Installation button.

"=l
| Deploy Process Customize Stage Install
[] Auto update 3 .
m @ Update from Nav — %
Installation Get Update from Instance folder  pownload Delete all
MetaData solution scripts
Settings Metadata Download Clear install

Select #9 Process Instance and click Run.

D Check Framework module: deployed

D Check MetaData: loaded

[] Get DWA scripts

["] Deploy Manual Scripts

[] Load DWA scripts

[] Generate SQL scripts for Dimensions
[] Generate SQL scripts for Cubes

["] Deploy instance

0 LN u AW N

Process instance

Select All

Deselect All

Check if Framework module has been deployed in previous steps, if not, deploy Framework
Check if Metadata has been loaded in previous steps, if not, run Get MetaData button

Copy all DWA scripts from cloud to your local instance (folders 1-6) for all modules in the license
Deploy manual scripts in main folders (1, 3, 4 and 5) and subfolder “#ManualScripts’
Load DWA scripts from folder 6 to memory

Generate SQL scripts based on dimension models and metadata

Generate SQL scripts based on cube models and metadata

Create SQL data warehouse and cubes

Process data from Microsoft Dynamics to data warehouse and cubes

x

Installation

) Installation completed

Wait for the “Installation Completed” message.

You have successfully installed data warehouse and analytics.




5.1. Edit instance

To edit existing Bl4Dynamics instance do the following:

1. Open instance
2. Click on File and press Edit

]

é_(l) New Instances
Bl4Dynamics AX

- Edit

e

[E Save

écla Delete

Q About instance

KG Update license

Q Properties

Q=

3. Make changes to instance. For example, in order to move analysis services to Azure change
Authentication to "Azure Active Directory” and input username and password to Azure portal in
the corresponding fields.

@ cditinstance %

Instance properties Copy Instance

Instance Name: Bl4Dynamics BC First Instance Copy current instance:

Language: e =) hd Instance Copy name: BI4Dynamics BC OnPremise COPY

Source is BC Cloud (SzaS): [m]

SQL Server Analysis Services

Database Name: Bl4Dynamics BC OnPremise COPY Analysis Database Name: Bl4Dynamics BC OnPremise COPY

SQL Server Name: ANDRIW10 - Analysis Server Name: ANDRIW10 -

Authentication: Windows = Analysis Server Option: Tabular -
Username: NPS-GROUPandrii Authentication: ‘Azure Active Directory -
Password: Username: NPS-GROUP\andrii

SQL Database File Locations: Password: [ERAE
Data: DAsaLz019wssaL1smssaLserverwssaLy [ Mode type: I 4
Log: DAsaLz019wssaL1smssaLserverwssaLy [

SQL Database Collation: Latin1_General CI AS -

Integration Services
Use Integration Services:

5515 Server name: ANDRIW10 Ver, 150

Test Connectivity Copy Instance

4. Click Save & Restart Instance.



5.2. Copy instance

To copy an existing Bl4Dynamics instance do the following:

5. Open instance
6. Click on File and press Edit

E Bl4Dynamics MAV; 9.1.0.363%; Instance: Bl4Dynamics BC First Instance

i ]
New Instances
1. Bl4Dynamics BC 1
Edit 2. Bl4Dynamics BC First Instance

3. Bl4Dynamics BC First Instance COPY

1 4. Bl4Dynamics BC OnPremise
Save

o

e

e

€5 tue
Q

Exit

7. Check Copy current instance and enter name for the instance that you create.
4. Note: copy name and all other modifications, i.e. database name, analysis database name are saved to
the copy, not current instance.

[ Edit instance X
Instance properties Copy Instance
Instance name: Bl4Dynamics AX Copy current instance
Language: English (United States) = Instance Copy name: Bl Dynamics AX COPY
SQL Server Analysis Services
Database Name: Bl4Dynamics AX Analysis Database Name: Bl4Dynamics AX
SQL Server Mame: ALEXW10 = SQL Analysis Server Name: ALEXW10
Authentication: Windows - Authentication: Windows.
SQL Database File Locations Username: GROUP\al
Data: DASQL2019\MssaL15.MssaLSERVERWMSSOLY [ . J
assword:
Log: DASQL2019\MSSAL15.MSsaLSERVERWMSSCLY [
SQL Analysis Server Option: | Tabular
SQL Database Callation: Latin1_General CLAS T v P
Model: Import
Integration Services
5QL Integration Service
SSIS Server name:  ALEXW10

8. Press Copy Instance button, button is disabled when entered settings are not valid - instance with such

name already exists, connection to servers cannot be established, etc.
9. Open copied instance, navigate to Deploy tab and Click on Deploy All.

- SoEdit 5
add SoRemove B

5QL2017
Demo Database NA..

il 17.0. NPS-GROUP\a...

- % o {1 Stage
bt & i% Data Warehouse

i ] Companies Modules Degllloy [ Analysis Database

Deplay manual
scripts only

(1 Iy

Deploy &
Process All




10. Once the instance is successfully deployed open Customize tab, make sure Update from Instance
folder is selected, and Get Metadata.

Deploy Process Customize 1 Stage Install 3
[] Auto update y
ﬁ% g n @ ) Update from NAY 2
Manage Manage Reload Wizard Get I' Update from Instance fl3"‘15"'1 ;
Model Dimensions Sources MetaData Documentation
Maodel Dimensions Wizard Metadata Help Translations

11. As a last step, Open Process tab and click Process.

Deploy Process Customize Stage Install

- L . .
£ L Full ', ] i stage Name: Bl4Dynamics BC First Instance COPY @ "’
® Incremental S V| i Data Warehouse (3] .
Edit - Process ; . | 13/09/2022 4, | Dail ~| Create  Account
5515 V| []Analysis Database |Full - | Database ~| Strt - m = schedules
Process Flow SSIS Update Process All Process one SQL Agent Job Extra

5.3. Edit process flow

Process flow is used to determine the sequence of execution of stored procedures when processing data
with Bl4Dynamics. Editing process flow is completely optional and it is usually connected with custom
development.

9@5 Full :, : ;ﬁ;t:ie\v\farehguse Name:  BI4Dynamics BC First Instance ..‘ :",
s ® neremental - process ¥l []Analysis Database |Full ~||Database ~| =T (16052022 @] [paiy m| Creste Acoount
Process Flow SSIS Update Process All Process one SQL Agent Job Extra
1 2 3 4 ) 5 6
1. Edit existing Process flow or Add a new one
2. Select Full or Incremental Processing type
3. Process All (Stage, Data Warehouse and Analysis Database)
4. Process just one on the above.
5. Create SQL Agent Job (with the specified periodicity and start date)
6. Process only Account Schedules instead of entire Analysis Database

If you click on Edit SSIS, you will have the following tab and options on it:

Deplay Process Customize Stage Install
£ BlMDynamics  ~ es-Reset - "

Edit ("Reload —d
5515

Process Flow SSIS Object group SSIS package

1 2

1. Reset the Process flow (return to original state) or Reload Process flow (include stored procedures
saved in Bl4Dynamics folder structure)

2. Create a new Object Group (standard 1-13)

3. Add or Remove a SSIS package from file



Edit Proc Flow 55IS %

Object group 1 Process steps Rename §
a4

No  Name Custom | [] Include  Crder  Process  Object Name Object subgroup Executed | Custom | Last exec time (sec) Object subgroup
0 SsIS v 166 [ Run | [fact][TruncateExecutionLog] CubeFramework v 0 Clzeacl AccountSchedule
1 SnapshotDate 167 [ Run | [fact][TruncateEmployeeAbsence] EmployeeAbsence v v 0 ew
2 Snapshot 168 [ Run | [fact][LoadEmployeeAbsence] EmployeeAbsence v v 0 | vpoxe |
3 DimDate 169 [ Run | [fact){TruncateFAEntry] FAENtry v v 0
4 DimHelp 170 [ Run | ffact){LoadFAEntry] FAENtry v v 0
5  DimLoadBefore 171 [_Run | [fact].{TruncateMaintenanceEntry] MaintenanceEntry v v 0
6 DimLoad 172 [ Run | [fact][LoadMaintenanceEntry] MaintenanceEntry v v 0
7 DimLoadhfter 173 [Run | [fact][TruncateMaintenanceRegistration] MaintenanceRegistration v v 0
8  FactDropConstraintindex 174 [ Run | [fact][LoadMaintenanceRegistration] MaintenanceRegistration v v 0
9 FactHelp 175 [ Run | [fact]{TruncateAccountschedule] AccountSchedule - - 0
10 FactloadBefore 176 [fact].[LoadAccountSchedule] AccountSchedule v v 0
11 Factload 177 [ Run | [fact]lLoadAccountScheduleMany] AccountSchedule v v 0
12 FactloadAfter 178 [ Run | [dim] [UpdateCustomRollupCalculation] AccountSchedule v v 0
13 FactCreateConstraintindex 179 [_Run | [fact][TruncateAccountScheduleCostAccounting] AccountScheduleCostAccounting v v 0

2 3

1. Object group name.

All stored procedures within object group are executed before the next Object group is executed.
Each Object group forms a separate SSIS package which is executed on processing.

2. Select/unselect a stored procedure to be executed on processing

. Run the stored procedure manually from the application

4. Object subgroup name. Stored procedures within an Object subgroup are executed successively,
while different Object subgroups within same Object group are executed in parallel.

5. Rename Object Subgroup option

w

170 [fact].[LoadFAEntry] ‘
) 55lg
171 Run | [fact][TruncateMaintenanceEntry] Iy
SnapshotDate
172 Run | [fact].[LoadMaintenanceEntry] Snapshot v
173 Run | [fact][TruncateMaintenanceRegistration] DimDate ist
. ) ) DirnHelp L
174 Run | [fact][LoadMaintenanceRegistration] DimloadBefore ist
175 Run | [fact].[TruncateAccountSchedule] DimLoad 2
DimLoadAft
176 Run | [fact].[LoadAccountSchedule] ImioasAtker 3
FactDropConstraintindex
177 Run | [fact][LoadAccountScheduleMany] FactHelp B
178 [ Run | [dim].[UpdateCustomRollupCalculation] FactloadBefore
Factload
179 Run | [fact].[TruncateAccountScheduleCostAccount " 2(Cq
FactlLoadAfter
180 Run | [fact][LoadAccountScheduleCostAccounting FactCreateConstraintindex #(Cq

Right-click on a stored procedure gives you an option to move it to a different Object group if needed
(on reset Process flow the stored procedure will be moved back to original Object subgroup).

Permanently moving a stored procedure to a different Object group is possible by adding a DECLARE
clause in the stored procedure itself:

EXEC dbo.DropObject 'fact.LoadInventoryState', 'P’
GO

-ICREATE PROCEDURE fact.leoadInventoryState

@InsertedRowCount int = @ OQUTPUT,
@output nvarchar(max) = NULL QUTPUT
AS

DECLARE @0bjectGroup nvarchar(255)='FactLoadAfter’

By adding or changing declare statement store procedure’s execution flow is determined.



5.4. Manage Partitions

Partitions divide portions of data you need to process (refresh) frequently from data that can be
processed less frequently. For example, a fact table may include certain row sets that contain data that
rarely changes, but other row sets have data that changes often. There's no need to process all of the
data when only a portion of it needs to be processed.

Partitions work by dividing a table into logical partition objects. Individual partitions, each containing a
unique segment of data, can then be incrementally processed either sequentially or in parallel
independent of other partitions, or excluded from processing operations altogether.

This feature can be only used with SQL server enterprise edition or with PowerBIl premium.

i £

Deploy Process I Customize I Stage Install
[
S Ml s O @

Manage Manage Manage Reload Wizard Get
Maodel Partitians Dimensions Sources MetaData
Model Dimensions Wizard

1. Open the Customize ribbon
2. Select Manage Partitions

Cubes Facts

Process last # partitions.
(Including current and all future

- |

Cube Name Use Fact Name Date field to partition by eploy Process

Common Measures GL Analysis
FA Analysis

DatelD

<

[] GLBudget DatelD v
GL Analysis

Inventory Analysis

Project Analysis

Purchase Analysis

=u
Deploy All Process All Deploy

Select the Cube.

Select the Fact.

Select the Date field to Partition by.

Select the number of last partitions processed (this is determined by how much backdating is
done).

Deploy the fact.

6. Process.

Hwn =



5.5. Setup Bl4Dynamics precision

Numeric data types can be stored in SQL with different precision, scale, and length.

Precision is the total number of digits that can be stored both to the left and right of the decimal place.
Scale is the number of digits to the right of the decimal point in a number.

Length is the number of bytes that are used to store the number.

In SQL the default maximum precision and scale for a particular length is the following:

e 195 9 bytes
e 27,10 = 13 bytes
e 38,20 = 17 bytes

During the installation, the following error might occur on stage:

Some errors occurred during executing package SSIS Stage: [G_L Entry].[dtsx].
Detail msg: Arithmetic overflow error converting numeric to data type numeric.!

It should be addressed by increasing the precision (e.g. from 19 to 38) and scale (e.g. from 5 to 20).
The default maximum precision of numeric and decimal data types is 38.
To change it in application you need to:

1. Open the instance and click File > Properties.

-

— & MNew Instances
£

1. BI4Dynamics BC
- Edit
€
[H Save
é? Delete
Q About instance

KQ Update license

O Properties
Qe

2. Under Instance Setup > Data Warehouse Properties precision could be set up for:
e Stage tables
e Datawarehouse tables

Application Areas Data Warehouse Properties

= Insta Setu

nstance P Clustered Columnstore Index (CCI) on 5tage tables: [

Instance Properties '
Clustered Columnstore Index (CCI) on Fact tables: |

I Diata Warehouse Properties I

:

Decimal Precision for Stage tables: 38,20

Analysis Properties ] .
Decimal Precision for Fact tables: 38,20

Configuration
Apply
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1. Open Tabular editor
2. Go to File > Open > From DB
3. Select the Server and Instance where you want to create calculation groups
4. Select Model and New Calculation group
File Edit View | Model | Tools
@ @ | @ | Perspec{ 1 Deploy.. F6 translg
)) E @I Import Tables...
v () {Model | Refresh Table Metadata...
> Data Sources
Perspectives New Table Alt+3
> Relationships +
: 2::; Expres New Calculation Group ~ Alt+7
» Tables New Data Source (Legacy)

> Translations

New Perspective

New Role

New Translation

New Data Source (Power Query)

New Shared Expression

MNew Relationship

5. Add new Calculation items with DAX query

File Edit View Model
2 D | @) | Perspective: (All objects)

Calculation ltem  Tools

v Translation: (No translation)

v @ Model
> Data Sources
Perspectives
> Relationships
Roles
Shared Expressions
v Tables

v HBf Calc_Group Date Last 3M
v . Calculation ltems

™ Name
> B@ Calc_Group Date Last 4W

v

Filter

Iv |

Expression Editor  Advanced Seripting

I Filter objects by name. Put a ;' as the first character to

Al X %‘_v % | 2 & = 7= | Property: Expression 2d
1 CALCULATE
2 SELECTEDMEASURE( ),
3 DATESBETWEEN (
4 'Date’ [Date],
5 DATEADD ( STARTOFMONTH ( 'Date'[Date] ), -1, MONTH ),
6 DATEADD ( ENDOFMONTH ( ‘Date’[Date] ), -1, MONTH )
7
8

6. Right click the new Calculation group, select Script > Create or Replace > To Clipboard

Create New »
Make invisible Ctrl+|

Show in Perspectives J
Hide in Perspectives 4

Duplicate Calculation Group
Delete “Calc_Group Date Last 3M"...

» BB Document FA Lending
» BB Fixed Assets Statistics

» A Civad Asoate Nanrani=tine

@=l4] | =
Script » Create or Replace  » || To clipboard |\ i
Create » To file...
Alter LI b
Delete >




7. Open Bl4Dynamics application and open instance

Deploy Process Customize Stage Install ETL
% ( | [] Auto update -
“ i . @ O Update from NAV él
Mﬂgégf Dihr?ﬁe%i?gns REI%%%:‘E‘L_'ZSEM Me(tiae[t)ata ® Update from Instance folder ~ Documentation

Maodel Dimensions Wizard Metadata Help Translations

8. Go to Customize tab > Manage Dimensions
9. Select New Calc. Group, add a name and copy the script

Total number of wizard dimensions: 103

Generate All Generate All
BI4AX n

Add a new Calculation Group

Name:

lCa\(iGmup‘\

Tmsl command:

“isHidden" true,
"sourceColumn”; "Ordinal”

1
“partitions™ [
{
“name": "Partition”,
“mode”; "import",
“source”: {
"type™ "calculationGroup"
}
}
1
"annotations”: [
{
“name": "Bl4-Cust-Type",
“valug™ "BI4-DIM-CALC-GROUP"

10. Update and Generate all under Calculation groups
11. Deploy and Process analysis database

5.7. Deleting instance

1. Open the instance you would like to delete by clicking File and selecting the instance in the list
on the right.
2. Click File > Delete.
3. Click Yes to confirm the action.
IMPORTANT! When deleting an instance, the Data Warehouse and Analysis Database will be deleted.

Note: Bl4Dynamics Instance folders and the log file are not removed during the delete process.
Uninstalling Bl4Dynamics

Click Start > Settings > Control Panel.

Click Add or Remove Programs.

From the list of installed programs, select BI4Dynamics.
Click Remove.

Follow the instructions on screen.

vk wn =

IMPORTANT! User files will not be removed when uninstalling the solution.



6.1. Downloading Excel and PowerBI reports

Open Instance

Go to Install tab

Click Download reports

Select the destination

Standard reports will be downloaded that are included with Bl4Dynamics

vk w2

6.2. Connecting Excel reports G e ’

Usage Definition| Usedin
Connection type: ~ Office Data Cannection
Connectionfile: | C\Users\mgvozden\Documents\My Data Source| | Browse...

1. Open Excel report ] s s connection e

Connection string: - provider=MSOLAP.G;Inteqrated Security=SSPLPersist Security
Info=Truelnitial Catalog=Bl4Dynamics BC:Data Source=.

2. Click Data > Connections > Properties >Definition T e

IMember Mode=Error;Update Isolation Level=2

3. Type the database name to the Initial Catalog property of Qs posre

Command type: | Cube ~

the Connection string. Type the Server name to the Data | cowstes i
Source property of the Connection string.

Excel Services: Authentication Settings...

Edit Query.. Parameters Export Connedtion File...

4. Open Microsoft Excel
5. Click Data > Get External Data > From other Data Source > From Analysis Services.

=] s Bookd - Excel T m - 0 ox
HOME  INSERT  PAGELAYOUT  FORMULAS | DATA | REVIEW  VIEW Tiaga Gruden =
. v [ Connections | 4| [ETR] % Tear Y 5 Flash Fill s Consolidate &l Group -
I VoRa IR ¢ BB
© 5 properi Reapp B+f Remove Duplicates [ What-If Analysis = G Ungroup +
GetExtemal  Refresh  Refresh 3L Set  Fiter Ted ta
Data*  from CRM  All~ Edit Link A Yo Advanced  Colymns S Data Relatianship ] subtatal
o Connections Sort & Filker Gutlir -
@[ [z [3 .
From From From From Other .
Access Web Text Sour c £ £ s H ! ! K L M N ©
Get Bxteral
From SQL Server
N Create a connection to a SQL Server table. Import data into Excel asa
5 Table or PivotTable report.
5 From Analysis Services
7 Create a connection to a SQL Server Analysis Services cube. Import data
s into Excel as a Table or PivotTable report.
9 F, FromWindows Azure Marketplace
10 .\=/ Create a connection to a Microsoft Windows Azure DataMarket Feed.
1 **  Import data into Excel as a Table or PivotTable report.
12
13
Sheetl ® . v
READY B om M- t 4+ 100%
Data Connection Wizard X Data Connestion Wizard -
Connect to Database Server Conneet to Datsbase Server
Enter tne Information required to connect to the Jataoase server. o conpet

1. Server name: | BOYNAMICSRERVER

cancel [ «pack neat Enin.

cancel <pak Hest >

un

Do not enter “."” for local server as this connection will not work on another PC.
If you have installed analytics on Azure Analysis Services or Power Bl workspace, paste the in the
field Server name.

If analytical database is installed in Azure or Power Bl workspace use connection link instead of Server
name. Examples:
Azure Analysis Services: asazure://westeurope.asazure.windows.net/bi4ddynamicshybrid



Power Bl Premium: powerbi://api. powerbi.com/v1.0/myorg/Bl4Dynamics%20PPU%

7. Click Next and select Analysis database from the dropdown menu and select Model

Data Connection Wizard ? X Import Data A=
Select Database and Table Select how you want to view this data in your workbaok.
Select the Database and Table/Cube which contains the data you want. E O Table
@ PivotTable Report
Select the database that contains the datayou want: PivotChart
Bl4Dynamics BC v Power View Report
Connect to a specific cube or table: [E® © Only Create Connection
Name Description  Modified Created Type fberdaaliatiaantini puii el
[uioae | 14/01/2021 10:59:04 cuBe @ Existing workshezt:
=sasi]
") New worksheet
Add this data to the Data Model
Propertes.. | [ o ][ conea
< 2 .
Cancel < Back Finish

8. Click Finish and OK on next form.

You have successfully connected Excel to Analysis Services model.

9. Start exploring your data by dragging and dropping dimensions and measures in pivot table

H 9- B Bookd - Excel PIVOTTABLE TOOLS
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ANALYZE DESIGM
&D 5{) Calibri B TR AR ’?f' %WrapTat Custom
By -
Pate o B I U~ E- DA E=E &3 EMegebiCenter - T 0% o ) f§  Conditional Formatas
- Formatting ~  Table -

Clipboard & Font [F} Alignment [F} Number ] Styles

E10 - F

A B C D E F -

1 Company All hd PivotTable Fields

2 Customer by Postin All -

5 Show fields: | (All)

4 Row Labels - | Avg bl C Net % Receivables Sales On Credit T

5 | #2008 1.012.801,74  762.146,85 17 6.053.834,29 ClSIOmeyDatit

6 |=2009 1.113.668,65 24.070,24 »31  6.770.320,55 Custemer Discount

7 #2010 1.010.116,26 563.732,89 .38 7.915.596,64 +| Customer Net Change

8 | ®2011 1.656.079,38 1.980.774,71 43 11.393.663,21 Sales

o | #2012 3.330.724,69 1,00 7| Sales On Credit

10 | ®2013 3.330.724,69 1,00 1! Sales on Credit (in %)

11| 82014 3.330.724,69 1,00 3 Additional Currency

12 Grand Total 3.330.724,69 3.330.724,69 100,00% 32.133.414,69 b Posted Currency

13

1 4 T Receivables Analysis

15 % of Total Receivables Balance
16 % of Total Sales
17 7| % Receivables Overdue
18 Avg Due Days Receivables
19 Avg Open Days Receivables
20 +/| Avg Receivables
2 Receivables Balance
%? - Receivables Coefficient

Sheetl Bl4Dynamics [l »
READY

(£

Insert Delete Format

T EH - O %

Tjasa Gruden =

v

Sort & Find &
Filter - Select =
Editing -~

=

s

zAutoSum -
Fill -

£ Clear~

Cells

Drag fields between areas below:

T FILTERS
Company M

Customer by Posting Group ¥

Il COLUMNS
T Values A

= ROWS
Date YMD -

2 VALUES
Avg Receivables v ||~
Customer Net Change i

% Receivables Overdue <2

Defer Layout Update

=

 -——F—+ 100




6.3. Connecting Power Bl reports

1. Open Power Bl report
2. Click Edit Queries > Data source settings

A=} = | Bl4Dynamics NAV (SSAS) - Sales - v0.9 - Power Bl Desktop

“ Home View  Modeling Help
cut
Copy

[\-‘ il = [E] Text box r| New Measur -Ie)
[d image A New
Paste Get Recent Enter Edit Refresh New MNew Ask A Buttons From From Switeh Manage Publish
Format Painter Data~ Sources Data Querias ~ Page * Visual Question - rEShap" T Marketplace  File Theme~  Relationships “ ick Measure
Clipboard External dz Insert Custom visuals Themes Relationships Calculations Share
Net Sales % of total Sales Cost Invoiced Quantity Discount Amount
Sales Over 78M  23.04%  30M 992K  616.6K

3. Type the Server name to the Server field. Type the Database name to the Database field

SQL Server Analysis Services database

b MDX or DAX query {optional)

SQL Server Analysis Services database

Open Power Bl Desktop
Click Get data

Choose Analysis Services
Type the Server name and Database name

Choose Connect live =

®© N vk

If analytical database is installed in Azure or Power Bl workspace use connection link instead of Server
name. Examples:

Azure Analysis Services: asazure://westeurope.asazure.windows.net/bi4dynamicshybrid

Power Bl Premium: powerbi://api. powerbi.com/v1.0/myorg/Bl4Dynamics%20PPU%

9. Click OK and start exploring your data

You should see this screen:

You have successfully connected Power Bl to Analysis Services model.




